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1. INTERFAZ DE TERRAAMAZON  

 
TerraAmazon es un software de monitoreo de bosques basado en la librería TerraLib. La 
interfaz principal está dividida en tres ventanas que se describen en las siguientes 
secciones. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
La barra de herramientas está localizada en la parte superior de la interfaz de 
TerraAmazon. En ella se muestran accesos directos a varias funciones que se describen a 
continuación.  
 
 

 
 
 
 
 
 
 
 
 

MENU 

BARRA DE HERRAMIENTAS 

BASE DE DATOS 

ÁREA DE 
TRABAJO/DISEÑO 

VISTAS/TEMAS 

BARRA DE MENSAJES  
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 Database: Crea o conecta con una base de datos local o remota  

 
Add View: Crea una nueva vista. La vista heredará las características del sistema de 
referencia de los primeros datos insertados en ella. 

 

Add Project View: Añade automáticamente una vista que contiene como temas 
todos los layers involucrados en las reglas, el layer “cell” y el layer definido como 
área de interés.  

 
Add Theme: Crea una representación visual de un layer y sus components 
espaciales.  

 Add Multiple Theme: Añade multiples layers en una única vista.  

 
Add External Theme: Habilita acceso remoto a diferentes bases de datos, 
permitiendo importar datos espaciales.  

 Vector Grouping: Personaliza la visualización de un atributo de interés 

 
Add WMS Theme: Permite conectarse a un WebMapService para visualización de 
datos en un tema.Add WMS Theme: 

 
Create Google Theme: Permite visualizar en tema a API Google Maps.  

 Enable Project: Activa un proyecto existente.   

 
Process Control: Permite componer y comenzar un proceso para una determinada 
área 

 Scene Revisor: Visualiza las informaciones de las escenas a verificar.Scene Revisor: 

 Database Tree: Activa o desactiva el árbol de la base de datos.  

 Views Tree: Activa o desactiva el árbol de las vistas/temas.  

 Display: Activa o desactiva el area de trabajo/diseño.  

 
Enable Full Screen:  Muestra el área de diseño en pantalla completa.Enable 
FullScreen: 

 TerraPrint: Inicia el plugin TerraPrint usado para crear mapas, cartogramas y otros.  

 
Cloud Detection: Inicia el plugin de detección de nubes.  

 
PDI Plugin: Inicia el plugin de PDI, usado para el procesamiento digital de 
imágenes.  
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2. MAPA BASE 

 
El objetivo de esta sección es la cartografía de la deforestación para el año base. 
Sucesivamente se irá componiendo el ambiente de edición, trabajando sobre las 
imágenes, realizando el cierre y exportando los datos producidos. 
 

2.1. CONSTITUIR EL AMBIENTE DE TRABAJO 

 
2.1.1. CREACIÓN DE UNA BASE DE DATOS. 

 
TerraAmazon se basa en sistemas gerenciadores de banco de datos para almacenar todos 
los datos importados o producidos. Por lo tanto, la creación de una nueva base de datos o 
la conexión a una base de datos ya existente es imprescindible. 
 
Para crear una base de datos, es necesario instalar PostgreSQL u otro gerenciador en el 
computador o en el servidor. 
  
Después de la instalación de PostgreSQL y TerraAmazon, abrir TerraAmazon y crear una 
base de datos usando las siguientes 
instrucciones: 
 
Operación 

Click – Create 
Database Type – PostgreSQL 
Host – localhost (o dejarlo en blanco) 
Port – 5432 (o dejarlo en blanco) 
User – postgres  
Password – postgres 
Database Name – DEFORESTACION 
Encoding – Click – Get List  

Seleccionar – WIN1252 
Click – OK 
 
 
 
 
 
 
 
 
 
Nota: Cuando se crea una base de datos, se debe usar por default, el username  Postgres 
y la contraseña definida durante la instalación de PostgreSQL.  
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2.1.2. CONEXIÓN A UNA BASE DE DATOS EXISTENTE 
 
Para conectarse a una base de datos existente, cierre la base de datos que tenga activa. 
 
File » Close Database 
Click - yes 
 

 
 
 
 
 
 
 
 
 
 

 
Posteriormente proceder de la siguiente manera: 
 
Toolbar » Database 
 
 
Operation  

Click – Connect 
Database Type – PostgreSQL 
Host – localhost (o dejarlo en blanco) 
Port – 5432 (o dejarlo en blanco) 
User – postgres 
Password – postgres  

Click – Select Database  
Seleccionar – DEFORESTACION 

Click – OK 
 
 
 
 
 
 
 
 
Nota: Para conectar con una base de datos remota, introducir la dirección IP del servidor 
en el campo HOST. El usuario y la contraseña deben coincidir con aquellos que  el 
administrador de la base de datos creó.  
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2.1.3. CREANDO EL MODELO CONCEPTUAL  
 
El modelo conceptual estructura el ambiente de edición de TerraAmazon. Es el 
componente central alrededor del cual se definen los usuarios y sus funciones, los 
proyectos, las actividades, las reglas topológicas y los límites espaciales. 
 
Para crear el modelo conceptual, el usuario debe conectarse a una base de datos y 
proceder de la siguiente manera: 
 
Menu » Administration » Create Conceptual Model 

 
 
 
 
 

Nota: Una vez cuando esta operación modifica la estrutura interna de la base de datos, 
será necessário confirmar por seguridad la operación. 
 
Click – Yes (mensaje de confirmación) 
 

 
 
 
 
 

 
 
En la ventana siguiente, se debe definir el nombre, la proyección cartográfica y los límites 
espaciales del ambiente de trabajo. El layer creado consistirá en una cudricula regular  
que define las áreas que serán seleccionadas por los  usuarios. 
 
Configurar la nueva ventana de la siguiente forma: 
 
 
Cell layer 
 Name – TA_CELL 
 Click – Projection  
Projection – LatLong 
Datum – SAD 69 
Parameters 
 Unit – DecimalDegrees 
Click – OK  
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Al volver a la ventana de configuración del modelo conceptual, establecer las 
coordenadas de los límites inferior izquierda y superior derecha de su área. 

 
Box Information 

  LL (x): –74 
  UR (x): –44 
  LL (y): –18.22 
  UR (y): 5.28 

Resolution: 0.25 
  
 
Click – OK 
 
Nota  La resolución utiliza la misma unidad de la proyección elegida y define una celda del 
modelo conceptual. 
 
 
 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click – OK (mensaje de confirmación) 
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Para visualizar el nuevo layer TA_CELL, crear una vista nueva: 
 
 
Toolbar » Add View 
 
 Add View   
 View Name – Modelo Conceptual 
 Click – OK 
 

 
 
 
Para crear un tema, seleccionar la nueva vista en el área view/theme, posteriormente 
seleccionar el layer TA_CELL en el área de la base de datos y proceda de la siguiente 
manera: 
 
 Toolbar » Add Theme 

Click – OK 
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Para visualizar el layer TA_CELL, proceder de la siguiente manera: 
 
Barra de herramientas 

Click – Draw    
 
Para verificar las propiedades de las celdas, proceder de la siguiente manera:  
 
Menu File 
 Click – Restart database 
Ventana de Views/themes  
 Seleccionar – TA_CELL theme 
Barra de Herramientas 

Click – Draw     
 Click – Information      
 Click en cualquier celda 
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2.1.4. DEFINIENDO EL CONTROL DE ACCESO  
 
En esta etapa, los usuarios del proyecto – user_int (intérprete) y user_aud (auditor) – 
serán creados. Posteriormente serán asociados con grupos con permisos específicos para 
cada tarea que será llevada a cabo. 
 
Menu » Project Management » Access Control 
  
 
 
NOTA: En la lista de usuarios, el usuario postgres existe por defecto. Este usuario se 
genera automáticamente durante la creación del modelo conceptual y tiene permisos de 
administrador. El usuario y la contraseña son los mismos que se usaron cuando fue creada 
la base de datos. 
 
Para añadir usuarios, proceder de la siguiente manera:  
 
Pestaña User  
 User controller 
  Seleccionar – Add New User 
  Name – user_int 
  Password – 123 

Click – Add 
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Repita el mismo procedimiento para añadir el usuario user_aud 
 
 
Pestaña User  
 User controller 
  Seleccionar – Add New User 
  Name – user_aud 
  Password – 123 

Click – Add 
 

 
 
 
Para eliminiar un usuario, proceder de la siguiente manera:  
 
Pestaña user  
 User list 
  Click – user_int 
  Click – Remove 
  Click – Yes 
 
 
NOTA: Los usuarios que hayan realizado alguna acción dentro de un proyecto no pueden 
ser eliminados.  
 
 
 
Para cambiar la contraseña de un usuario, proceder de la siguiente forma:  
  
Pestaña user  
 User list 
  Click – user_int 
  Click – Password  
 
Password Control 
 New Password – 123456 
 Confirm Password – 123456 
Click – OK 
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Después de definir los usuarios, se deben crear los grupos y sus permisos asociados. Los 
grupos AdmGrupo y projectManagerGroup son generados por defecto durante la creación 
del modelo conceptual. 
 
 
Para añadir nuevos grupos, proceder de la siguiente manera:  
 
Pestaña Group  
 Group controller 
  Name – INTERPRETES 
 Click – Add 
 
  

 
 
 
  
NOTA: Todos los grupos beneficiaries de los privilegios de Operator Functions permiten 
interpreter las imagines. Los privilegios de Project Manager Functions dan acceso a todas 
las funciones necesarias para la gestión del proyecto mientras que los privilegios 
Administrator Functions dan pleno acceso a las herramientas de administración de las 
bases de datos 
 
 
 
Repita este procedimiento para crear el grupo AUDITORES  
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Para eliminar un grupo, proceda de la siguiente manera:  
 
Pestaña Group 
 Group List 
  Click – INTERPRETES 
  Click – Remove 
 
Los usuarios estarán asociados con uno o más grupos. Por lo tanto, estará garantizado 
que tengan permisos para llevar a cabo tareas específicas. 
 
Para asociar un usuario user_int con el grupo Interpretes, proceda de la siguiente 
manera. 
 
Pestaña User x Group  
 Group 
  Click – Interpretes  
 Users are not members  

Seleccionar – user_int y postgres 
Click – 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Repita este procedimiento para asociar el usuario user_aud con el grupo Auditores. 
 
Click – OK 
 
 
NOTA: 

 
 

 Un usuario asociado con un grupo no puede ser eliminado.  

 Únicamente un grupo puede tener permisos de administrador.  

 El grupo administrador nunca debe ser eliminado y debe incluir al menos 
un usuario.  

 



Tutorial TerraAmazon – Parte I 

 

Curso Online INPE/CRA                                                                                                        

15 

 

2.1.5. CONTROL DE FASE 
 
Uno o más grupos pueden estar asociados con cada fase del proyecto.  
 
Para crear una fase, proceda de la siguiente manera: 
 
Menu » Project Management » Phase Control 
 

 
 
New phase 
 Name – INTERPRETACION 
 Click – Add 
 Click – OK (mensaje de información) 
 
 
 
Phase List 
 Seleccionar – INTERPRETACION  
Phase X Group 
 Group – Interpretes 
 Click – Associate 
 Click – OK (Mensaje de información)  
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Repetir el procedimiento para crear el grupo AUDITOR, y la fase AUDITORIA y 
posteriormente asociarlas. 
 
Click – Close 
 
Para eliminar una fase, proceder de la siguiente manera:  
 
Phase List 
 Click – {Nombre dela Fase} 
 Click – Remove 
 Click – OK (mensaje de información)  
Click – Close 
 
NOTA: Las fases asociadas a grupos no pueden ser eliminadas.  
 
 
 

2.1.6. PROJECT MANAGEMENT 
 
Un proyecto define el conjunto de reglas relacionadas con el proceso de edición. Varios 
proyectos pueden coexistir dentro de una base de datos pero un usuario puede tener 
accesso únicamente a un proyecto activo al mismo tiempo. 
 
Para crear un proyecto y definir el máximo número de celdas en las que cada usuario 
puede trabajar al mismo tiempo, proceda de la siguiente manera: 
 
Menu » Project Management » Classification Control » Project Management 
 

 
 
 
Project 
 Name – DEFORESTACION 
 Number of locked cells – 6 
 Click – Add  
 Click – OK (mensaje de información) 
Click – Close 
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Para eliminar un proyecto, seleccionarlo y hacer click en Remove. 
 
NOTA: Un proyecto que contenga reglas no puede ser eliminado.  
Haga click en Enable Project                en la barra de herramientas para activar el  
proyecto. Seleccionar el proyecto DEFORESTACION y haga click en Activate. 
 
 
 

2.1.7. CREANDO LAYERS 
 
TerraAmazon permite a los usuarios crear nuevos layers usando diferentes métodos. En 
cada caso, la proyección y los límites deben ser definidos durante su creación. 
 
Para crear un layer, proceder de la siguiente manera: 
 
 
Menu » Layer » Create Layer 
 
Creation Mode 
 Click – New One  
 
Click – Next 
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Pestaña Layer Identification  
 Name – DEFORESTACION 
 Author – INPE_Amazonia 
 
Pestaña Extents  

Projection information 
  Click – Projection 
 
Configurar la ventana de proyección 
de la siguiente manera:  
 
Projection 
 Click – LatLong 
Datum 
 Click – SAD69 
Click – OK 
 
 
 
Será redireccionado a la ventana de configuración del layer. Defina los límites del layer 
similares a los del layer TA_TA_CELL :  
 
Box Information 
 Click – Use an existing layer box 

Select – TA_CELL  
Click – OK 
Click – No (visualización del tema) 
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Repita este procedimiento para crear los layers MASCARA, NUBES, BOSQUE, EDICION y 
TEST.  
 
 

2.1.8. ELIMINANDO LAYERS 
 
Esta función permite eliminar uno o varios layers de la base de datos activa.  
 
Menu » Administration » Delete Layers 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Añadir los layers a ser eliminados.  
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Click – Ok 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
En la ventana de búsqueda de layers, proceder de la siguiente manera:  
 
Layer Search 

List of Layers  
Click – TEST 

Click – OK 
 
Se redirecciona a la ventana Delete Layers. El layer seleccionado se muestra en el área 
Manage Layers to Delete 
 
Click – Delete Layers 
Click – OK (Information message) 
Click – Cancel 
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2.1.9. IMPORTANDO DATOS VECTORIALES  
 
Los datos Vectoriales pueden ser importados desde otras bases de datos o desde archivos 
externos.  
 
Menu » File » Import Data 
 

 
 
 
 
 
 
En la ventana Import, seleccionar el archivo vectorial a importar: 
 
Import Parameters 
 File – ..\AI_TM_AMZ_pol.shp 
 Click – OK  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Al final del proceso de importación, podrá elegir visualizar el vector en una nueva vista.  
 
Click – No 
 
Nota: Es el modelo conceptual y no el vector importado el que define el area editable. 
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2.1.10. GESTIÓN DE CLASES.  
 
Las clases son definidas para toda la base de datos y pueden ser asociadas con cualquier 
proyecto. 
 
Menu » Project Management » Classification Control » Class Management 
 

 
 
Para crear una clase, proceda de la siguiente manera: 
 
Pestaña Class  
 Class 
  Name – DEFORESTACION 
  Click – Add 
  Click – OK (mensaje de información) 
 
Repita el procedimiento para NUBES, BOSQUE, HIDROGRAFIA y NBOSQUE. 

 
 
 
 

 
 
 
 
 

 
 
 
 
 
 

Click – Close 
 
Nota: La pestaña Class x Group permite agrupar las clases para facilitar la configuración 
de proyectos que implican un gran número de clases. Sin embargo, no es obligatorio que 
las clases sean agrupadas. 
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2.1.11. GESTIÓN DE LAS REGLAS  
 
Una regla está definida por una operación espacial. Las operaciones espaciales que 
pueden ser relacionadas con una regla son: diferencia, intersección, unión y limpieza.  
 
Por ejemplo, consideremos los layers A y B como entrada y el S como el resultado. 
 
Diferencia: S=A-B; S almacenará todos los polígonos o todas las partes de los polígonos 
en A que no solapan con los polígonos en B. 
 
 
 
 
 
 
 
Intersección: S=A∩B los resultados se encuentran en la region de solape entre los layers A 
& B. 
 
 
 
 
 
 
 
 
 
 
 
Limpieza: esta function elimina el area del layer S el cual solapa el área del layer A. 
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Las reglas Diferencia y Limpieza son descritas a continuación en detalle.  
 
Menu » Project Management » Classification Control » Rule Management 
 

 
 
 
Para crear las reglas, proceder de la siguiente manera: 
 
Rule Params 
 Rule Name – DIF_DEFORESTACION 
 Operation – Difference 
 Layer Name – DEFORESTACION 
 Click – ADD (en el área Cell Column) 
Cellcolumn Name 
 Type – cell_oid 
 Click – OK 
 Click – OK 
 Select – cell_oid (en el área Cell Column) 
Click – Add 
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Rule Params 
 Rule Name – CLEAN_DEFORESTACION 
 Operation – Clean 
 Layer Name – DEFORESTACION 
 Select – cell_oid (en el área Cell Column) 
 Click – Add 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Repetir el procedimiento para crear las reglas Diferencia y Limpieza para cada layer de 
salida (NUBES, BOSQUE, MÁSCARA). 
 
Nota: La columna cell_oid se require para todas las operaciones que implican más de una 
tabla en la base de datos. Esta columna debe ser añadida sólo para los layers que no la 
contengan previamente.  
 
Click – Close  
 
Para eliminar una regla, seleccionela y haga click en Remove. Un mensaje de información 
aparecerá. 
 
Click – OK 
 
NOTA: Las reglas no pueden ser modificadas o eliminadas una vez que están asociadas a 
un proyecto.  
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2.1.12. CONTROL DE REGLAS  
 
La gestión de reglas define las relaciones entre proyectos, reglas y clases. Por lo tanto, son 
componentes que deben haber sido definido previamente. 
 
Los campos mostrados en la ventana de Rules Control se describen a continuación: 
 

1. Project: muestra la lista de proyectos definidos en la base de datos.  
 
2. Select Output Layer: asocial las reglas con el layer de salida.  
 
3. Output Layer List: permite añadir o eliminar layers de salida del proyecto.  
 
4. Rules: permite asociar una regla especial con layers de salida específicos.  
 
5. Attributes: permite asociar atributos del layer de salida seleccionada con otros 

layers existentes que tengan una regla de intersección entre ellos.  
 
6. Class List: permite asociar clases definidas en la base de datos con el layer de salida 

seleccionado.  
 
7. Clean: permite asociar las reglas de limpieza definidas en la base de datos con el 

layer de salida seleccionado.  
 
8. Validate: valida todos los components definidos en el proyecto (reglas, clases, layers 

de salida, etc.). Este paso es requerido para cada layer de salida con el fin de usar la 
estructura creada.  

 
Menu » Project Management » Classification Control » Rules Control 
 

 
 
 
 
 
 
 
 
 
 
 
 
Nota: Cada pestaña de la interfaz debe ser configurada de forma separada para cada 
layer que esté asociado con una o más reglas. 
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Para definir el control de reglas de la DEFORESTACIÓN, proceder de la siguiente forma: 
 
Project – DEFORESTACION 
 
Set of Rules 

Select Output Layer 
  Click – Manager Layers 
   Click – Layer 
    Select – DEFORESTACION 
    Click – Ok 
   Click – Add (parte inferior de la ventana) 
    Click – OK 
   Click – Close 

Select Output Layer 
  Click –       

Output Layer List 
Select – DEFORESTACION 

 Pestaña Rules  
  All Rules 
   Click –   

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ALL 
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Pestaña Class Columns 
   Click – ADD COLUMN 
 
En la ventana Class Name: 
   Type – class_name 
   Click – OK 
   Click – OK (mensaje de información) 
 
 
 

 
 
 
 
 

 
 
  Pestaña Class  List 
   Classes 
   Click – DEFORESTACION 
   Click –   
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Pestaña Clean  All Rules 
   Click – CLEAN_DEFORESTACION 
   Click –  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click – Validate 
Click – OK (mensaje de información) 
Click – OK (mensaje de información) 
 
 
 
 
 
 
 
 
 
Repita el procedimiento para el otro output (layer de salida). Seleccione para cada layer 
las clases deseadas y la regla CLEAN correspondiente. Recuerde que el layer MASCARA 
contendrá las clases HIDROGRAFIA y NBOSQUE.  
 
Valide cada layer de salida separadamente. Una vez que todos los layers han sido 
validados, haga click en Close. 
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2.1.13. DEFINIENDO EL ÁREA DE INTERÉS 
 
Un Área de Interés (AI) define las fronteras espaciales de una región geográfica. 
Únicamente serán considerados durante el proceso de clasificación los polígonos que se 
encuentren dentro de dicha área. En este tutoria, el area de interés sera delimitada por un 
vector que representa la Amazonía legal Brasileña (AI_TM_AMZ_pol). 
 
Para crear o definir un area de interés, proceder de la siguiente manera: 
 
 
Menu » Project Management » Interest Area 
 
 

 
 
 
 
 
 
 
 
 
Layer 
 Click – Search 
 Select – AI_TM_AMZ_pol  
 Click – Ok  
 Click – Add  
Search 
 Column – pathrow  

Filter – 22362  
Click – Apply  

All Geometries List 
Select – 22362 

Parameters 
 View Date – DD/MM/AAAA 

Click – Add 
Click – OK 

Click – Next 
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Nota: Para modificar la fecha de un scenario, 
seleccione el scenario y haga click en Update. 
Introduzca una nueva fecha y haga click en 
Update para confirmar la modificación. 
 
 

 
 
En la ventana de Project Associate: 
Project 
 Select – DEFORESTACION 
 Click – Set  
 Click – Finish 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Usted puede bloquear un escenario para el proyecto elegido para evitar que otros 
usuarios puedan accede a él. Para ello, seleccione el escenario a bloquear y haga click en 
Lock/Unlock. 


